S Secude

|}

HaloCAD

HaloCAD Add-on for Creo 2.2

Operations Manual




Copyright

© 2024-2025 Secude Solutions AG. All Rights Reserved.

This Secude-branded software and its corresponding documentation are the exclusive property of Secude Solutions AG of Luzern,
Switzerland and are protected under the various copyright laws around the world and by various other intellectual property laws. The
use of this software and/or its documentation and any copying thereof by end users is subject to the terms of a license agreement
with Secude Solutions AG. The wrongful use or copying of this software and/or documentation subjects infringers to both criminal

and civil liabilities.

ANY USE, COPYING, REPRODUCTION, ALTERATION, TRANSMISSION, OR TRANSLATION OF THESE MATERIALS, IN WHOLE OR IN
PART, IN ANY FORM OR BY ANY MEANS, IS STRICTLY PROHIBITED WITHOUT THE PRIOR WRITTEN PERMISSION OF SECUDE
SOLUTIONS AG. IF THIS MATERIAL IS PROVIDED WITH SOFTWARE LICENSED BY SECUDE, THE INFORMATION HEREIN IS PROVIDED
SUBJECT TO THE TERMS OF THE WARRANTY PROVIDED WITH THE PRODUCT LICENSE. IF THIS MATERIAL IS NOT PROVIDED WITH
LICENSED SOFTWARE, THE INFORMATION HEREIN IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND. IN EITHER CASE,
THERE ARE NO OTHER WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO THE IMPLIED WARRANTIES
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, NONINFRINGEMENT, OR QUALITY. IN NO EVENT SHALL SECUDE
SOLUTIONS AG OR ANY OF ITS AFFILIATES BE LIABLE FOR ANY DIRECT OR INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL,
PUNITIVE, OR EXEMPLARY DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE MATERIALS AND/OR INFORMATION
CONTAINED HEREIN. Some jurisdictions do not allow the exclusion of implied warranties, so the above exclusion may not apply to

you.

Secude Solutions AG takes reasonable measures to ensure the quality of the data and other information produced herein. However,
these materials may contain technical inaccuracies or typographical errors, and are not guaranteed to be error-free. Information may
be changed or updated without notice. Secude Solutions AG has no obligation to update these materials based on changes to its
products or services or those of third parties. Secude Solutions AG may also make improvements or changes to the products or
services described in this information at any time without notice. Secude Solutions AG frequently releases new versions and updates

to its software, and therefore images shown in this document may be slightly different from what you see on screen.

As with any security product, Secude Solutions AG highly recommends the back up of data as well as passwords on a regular basis.
Secude Solutions AG is not responsible for the loss of passwords or data that cannot be retrieved based upon a user’s failure to

adhere to stringent backup and safe-keeping conventions.

Contact

Secude Solutions AG
Landenbergstrasse 34
6005 Luzern
Switzerland

Tel: +41 41 5107070

Mail: info@secude.com

Support

Web: https://support.secude.com

Mail: support@secude.com



mailto:info@secude.com
https://secude.atlassian.net/servicedesk/customer/portal/1
mailto:support@secude.com

Table of Contents

T. ABOUT THIS MANUAL.........tiiitiiitiitteitreniereneeteaeeteassessasssssessssssnsssssnsssssnssns 1
2. GENERAL FAQS ... iiiiieirieittetettaeettanetteneessanssssnsssssssssssnsssssnsssssnsssssnssssanes 2
3. HOW DOES IT WORK?......eiteiiieiiiieiiiieetieeetteeitteneessenssssessssssnsssssnsssssnsssssnsssssnes 4
3.1. Lot Tl g o] o= g 1= o TSRS 4

3.2. Applying Protection using HaloCAD Add-0ON.........cooiiiiiieiiieieeeeeeee e 4

3.3. Viewing a Protected File Via the HaloCAD Reader Add-0n ..........ccooveviienieneenieieeeeeee 6

4. GET STARTED WITH HALOCAD ......couiituiiiiniiiiniiieneetineeteanessanessenssssensssssnsssssnes 7
41. Permissions Level and Usage RIGhS .........ccooiiiiiiiiiiiciccecee e 7
4.7.1.  BaSIiC PeIrMUSSIONS ...ouiiiiiiitiiiiiiitieetette sttt ettt et ettt 7

4.1.2.  CuStOM PEIMISSIONS ...c..ciiiiiiiiiiieniieiientene ettt ettt et et et 8

4.2. HaloCAD Screen INtrodUCTION .......ooveuiiiiiiiieeieie ettt 9

4.3. How to Protect @ CAD File (Standalone)? ...........cccueeiiviiiieiieiiecieeeeeeeeee e 12
4.3.1. Cancel, Remove, Relabel, and More...........cccccviiiiiiiiinieeee e 15

4.3.2. Logging Off @n ACHIVE USEN........c.ooieuieiiiiceeceeeeeeeeeeee ettt 16

4.4, How to Export a Protected CAD File to @ PDF Fil€?.......cc.ooiviiiieieeeieeeeceeee e, 18

4.5. How to View a Protected File in HaloCAD Reader?...........cooeoiviiineieinineeeeeseneeee e 20

5. COMMON SCENARIOS ........cuuiiiiitiiinitiniintieeeeettennesessesnsesstsesssssssssnsssssssssnnes 22
5.1. Concept: Sensitivity Labels .........coooiiiiie e 22

5.2. How to Open a Protected CAD Fil@7?..........oooviomieiieeeeeee ettt 23
5.2.1. Example 1: Label with Read-only ACCESS .........cccoooiiiuiiiiiiiecieeeeeeeeeeeeeee e, 23

5.2.2. Example 2: Label with Full Control ACCESS .........cccveiuiiiiiiiecieeeeeeeeeeeeeeeeee e, 25

5.2.3. Example 3: Unauthorized USEr ACCESS ..........ooouieicueeeeeeeee e 26

5.2.4. Example 4: Labeling Dependent (Protected and Unprotected) Files.............ccc.c....... 26

5.2.5. Example 5: Labeling Dependent (Unprotected) Files...........ccccoooveieiveiiiccceeeeeea 27

5.2.6. Example 6: Removing Protection from Assembly & Part Files ............ccccccecveuvennnnnnne. 28

5.2.7. Example 7: Label with Content Marking ...........cccoooieiiiiiiiiciicceceeceeeeecee e, 28

5.2.8. Example 8: Other Use Case SCENAIIOS. ..........cocueeeiuiieeieeeeee e 29

5.2.9. Example 9: Custom Permissions Label..............cccoooooiiiiiiiiiieeeeeeeeeeeeee e, 31

5.2.10. Example 10: Set an Expiration Date for File ACCESS ........cccevveviieiiciicicceeeeeee, 33

5.2.17. Example TT: ReVOKE @ File.........cooviioeeieeeeeeeeeeee e 34

6. TROUBLESHOOTING ........ccoeiiiiiiiiiiiiiiiiiiiiiiiiiiiieieieeeeeeeeeeeeeeeeeeeeeeeeseesesssesesssesssseees 38



6.1. Cannot Sign in to Microsoft Sign-In Assistant............cccocooiiiiiiiiiicececeeee e 38
6.2. Labels are not Getting Downloaded in the HaloCAD SeSSioN..........cccceeveeriienieeniieneeeeereein, 40
6.3. Label Not FOUNd iN the POLICY......cc.iiiiiiieiieeeeeeee ettt e 41
6.4. Double Key Encryption Label Could not be Applied..........cccoeoieiieiieiieieeeeeee e, 42
6.5. Could not Connect 10 AZUre RMS = CaSE T ....eeiiiiiiiieiieecieeeeee et 43
6.6. Could not Connect 10 AZUre RMS = CASE 2 .....ooiiiiiiiieiieecieeieeee sttt 44
6.7. HaloCAD ACHIVatioN FailS ........ccoiiiiiieee ettt 45
6.8. Incorrect License Key Error ME@SSAQE. ... .coouiiiiiieiiie ettt ettt e 46
6.9. Why Am | Getting License Expiration Notifications? ............ccoceviiiiieciiicicceeceee e, 47
6.10. Other License Related Error MESSAQES .......cccviviiiieiiieeiieeiie et sitesiee st sieeseeseeesteesreesseesseesneens 48
CUSTOMER SUPPORT .......iteiiiiiitiinieeittenieieeeeteneetsasssssasssssasssssansssssnsssssnssns 49

DOCUMENTATION FEEDBACK .........ccoiiiiiiiiitiiiiiiinniittninncneceeeensssasieeeeeees 50



Typographic Conventions

This guide uses the following typographic conventions to distinguish types of in-text information and icons

to alert you to important information.

Convention

Boldface type

Italic type

Consolas Font

Hyperlink

Admonitions

Description

Items you must select, such as menu options, command buttons, or items
in a list.
Titles of sections, sub-sections, etc.

To emphasize a word
Error messages
Table and Figure captions

Package names

Filenames and directory names

XML element names and attribute names
Parameters

File type

Code examples

Example:

hesadm.exe start -user <domain\user> -pwd <password>

Provides quick and easy access to cross-referenced topics. Hyperlinks are
highlighted in blue and underlined.

Note

Contains detailed information about a topic and are of direct
importance to the subject at hand.

Warning

Contains information about circumstances, parameters, and so on that
MUST be fulfilled. Failure to comply will have consequences for the
current operation.

Tip
Contains useful information about the operation of the application.

Info

Contains information, guidelines, or suggestions for performing tasks
more effectively.
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1. About this Manual

This manual provides comprehensive guidelines and step-by-step instructions for working

with HaloCAD solutions (Label and Protect). Please refer to the Installation Manual included with the

product package for information on deployment and configuration.
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2.General FAQs

This section provides answers to the most frequently asked questions (FAQ). If you have any further

inquiries, please contact our sales representative or our support team.

1.

What does HaloCAD provide for an organization?
HaloCAD solution protects engineering CAD files and enforces security throughout their full life

cycle.

. How many variants does HaloCAD have?

There are three variants available:
a. HaloCAD Add-on for CAD application (as a standalone add-on)
b. HaloCAD for PLM
c. HaloCAD Reader Add-on for CAD application

. What is the difference between the HaloCAD Add-on for CAD and the HaloCAD for PLM?

HaloCAD Add-on for CAD is a standalone solution for organizations that do not store their CAD files
in PLM, and it enforces protection through user engagement.

HaloCAD for PLM integrates with the respective PLM application and includes the capability of
HaloCAD PROTECT and HaloCAD MONITOR, where the MPIP label is applied without user

intervention based on how the rules defined in the Classification Engine are applied.

. What distinguishes the HaloCAD Reader add-on from the HaloCAD Standalone (full add-on)?

The HaloCAD Standalone add-on (full version) protects CAD files using Microsoft's Purview
protection solution, whereas the HaloCAD Reader add-on just allows you to view HaloCAD
standalone protected files. In addition, the HaloCAD standalone add-on is licensed. In contrast, the
HaloCAD Reader add-on is free.

. What languages are supported by the HaloCAD add-on?

Currently, the HaloCAD add-on only supports the English language.

. Does the HaloCAD Add-on support all native CAD file types?

Yes, the HaloCAD Add-on supports all CAD native file types.

. What happens if an unauthorized person tries to open a HaloCAD-protected CAD file?

At first, user authentication takes place. It is a process of verifying the identity of the user. If the user
fails during the authentication, he/she will be prompted with an error message and access will be

denied.

. Who decides what labels should be used for various CAD drawings and how it is managed in the

background?

An administrator in an organization creates and manages labels (user rights) in the Microsoft

Operations Manual 2 of 50
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Purview portal. Engineers can create a profile, a classification schema, and an action rule based on
the sensitivity of their data.
9. What if | don't want a certain file to be protected?
If you don't want the file to be protected, you can apply the "No Protection” label, which does not
contain policy properties.
10. Can | create my own labels?

Yes, HaloCAD allows users to create custom permissions labels.
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3.How does it Work?

3.1.

License En

forcement

After installation, HaloCAD programmatically sends a license validation request to Secude's License

Manager when a user tries to log into a session for the first time (by opening the CAD application).

There are two scenarios based on administrator installation.

Case 1: The license will be activated automatically during the installation process, and you will be able

to continue using the HaloCAD features.

Case 2: If not yet activated, the user will receive an error message and will be unable to access the

HaloCAD features. Please refer to the Installation Manual for more information about license activation.

3.2. Applying Protection using HaloCAD Add-on

At a high level, HaloCAD workflow involves the following steps:

Windows Client

%

p== N .2. john@halosecude.onmicrosoft.com

CAD Application

®

Custom Permission

%)

HaloCAD

Standard version @

User A

Protected file access
File 1
[ ]
—Ej— &
L
Windows Client Full
(CAD Appl)) permission
File 1

—g—&

File 2 File 2 . User B 4 .
Confidential File 1 Shared with Windows Client Read-.On.Iy
C Secret Label other users (CAD Appl.) Permission
- Secret
B Public ’ .
Protected files File 1
Original fil Label list
riginal files abel lis i 0 g
User C
User authentication Windows Client
and label download (CAD Appl.)
. . (]
Microsoft Purview Q i E %
Information Protection User D T
Windows Client Access
@ @ — (CAD Appl) Revoked
@ Microsoft Entra ID
(halosecude.onmicrosoft.com) User authentication
\_ J
HaloCAD protection
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1. To create new CAD files, a user launches the CAD application and logs into the HaloCAD session for
the first time.
2. HaloCAD connects with your Microsoft Entra tenant. This manual uses the tenant

halosecude.onmicrosoft.com as an example.
a. Microsoft Entra ID requests for user identification.

b. Microsoft Purview Information Protection (MPIP) labels are downloaded for the logged-in user

(john@halosecude.onmicrosoft.com) following successful authentication.

3. File protection: On two files, the user (John) chooses and applies two distinct labels.

4. HaloCAD enforces the document's protection settings based on the label that is selected. When a
user assigns a sensitivity label, it is saved in the document's metadata and the label's protection
settings are applied to the content to protect it.

5. File-Sharing: Assume that john@halosecude.onmicrosoft.com shares the files with several users.
User A, B, and C receive File 1, while User D receives File 2.

6. Content consumption: Users A, B, C, and D attempt to access protected information. Microsoft Entra
ID verifies each user account, and the file opens after successful authentication. Users are granted
usage permissions like View, Edit, Print, Copy, Export, and Change depending on the label applied.
Different levels of usage rights will be granted to each user or user group. Note: The user who
initializes HaloCAD will be the author and have full rights to the document. For more details about

labels, please refer to the Microsoft Documentation.
a. File 1-The fileis fully accessible to User A@halosecude.onmicrosoft.com.
b. File 1-Access is read-only for User B@halosecude.onmicrosoft.com.
c. File1-User C@halosecude.onmicrosoft.comcannot open the file.

d. File 2 - File access was previously granted to User D@halosecude.onmicrosoft.com, however,

it was revoked due to risky suspicious activity.

Logged-in user (HaloCAD session)

In this document, 'logged-in user' refers to the person or user account who has launched the CAD
application and signed into Microsoft Entra ID (through the Microsoft Sign-In application). This
may not depend on the operating system user who is currently signed in. It is collectively referred

to as the 'HaloCAD session'.
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3.3. Viewing a Protected File Via the HaloCAD Reader Add-on

At a high level, HaloCAD workflow involves the following steps:

/ CAD Application \
HaloCAD session m

HaloCAD
Reader version
—_— Authorized to open ( )

— - Microsoft Purview
with read-only access

File 1

Windows Client Information Protection

— »
@ cfo 4G

authentication
End User @
p— File with no access Microsoft Entra ID

N\ J

Protected Files

o J

1. A user selects a file protected by HaloCAD.

2. The first time logging into the HaloCAD session requires a connection to Azure RMS. Microsoft Entra
ID verifies the authenticity of the user.

3. HaloCAD warns you that the file can only be opened in read-only mode. In this example, the user is
authorized to open File 1.

4. However, the user lacks the necessary permissions to open File 2, therefore the file cannot be

opened.
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4.Get Started with HaloCAD

This section describes how to protect a file, open a protected file, and use the HaloCAD Reader add-on.

4.1. Permissions Level and Usage Rights
4.1.1. Basic Permissions

The following table lists the basic permissions and the usage rights that they contain:

S.No Permission Level Usage Rights (Allowed Recipient Actions)

1 View Open and read the data (also known as “Read-only”). It includes Zoom

and view from different angles (for CAD file types).

2 Edit Edit the file and save it

3 Copy Extract data (including screen captures) from the file into the same or
another file.

4 Print Print the content

5 Export Save the content to a different filename (Save As). Also includes

“Export to PDF”.

6 Change Rights Changing the label that is applied to a file includes removing protection

and saving it as an unprotected file.

7 Owner (Full Control Grants all rights to the file and all available actions can be performed.

rights) And includes the permissions below:

1. Remove protection
2. Relabel a file

Author (creator) of a file
The author of a file has all rights and actions mentioned in the above table. Also includes the
below permissions:

1. Open file after the expiry date

2. Revoke access

Operations Manual 7 of 50
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4.1.2. Custom Permissions

The following table lists the custom permissions and the usage rights that they contain:

S.No

1

Permission Level

Viewer

Reviewer

Co-Author

Co-Owner

Only for me

Usage Rights (Allowed Recipient Actions)

Open and read the data (also known as “Read-only”). It includes Zoom

and view from different angles.
Viewer's allowed permissions plus:

1. Edit
2. Save the file

Reviewer’s allowed permissions plus:

1. Print
2. Extract data (including screen captures) from the file into the same or

another file.
Co-Author’s allowed permissions plus:

1. Export
2. Change Rights

Grants all rights to the file and all available actions can be performed

only by the author of the file.

Operations Manual
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4.2. HaloCAD Screen Introduction

After installing the HaloCAD add-on, you can notice the HaloCAD tab in the CAD application as shown in
the below figure:

fereor |18 W

ur Rl

22 | ¥ EXPS (PART) (Active) - Creo Parametric

HaloCAD Maodel Analysis Live Simulation Annotate Tools View Applications
Wl |
9 &
Status About Sensitivity HaloCAD tab in Creo
Information
a
oo Model Tree = Folder Br # | Favorites | &
2 = B 2 </ Sensitivity | Mot set -
Model Tree TE - §_E—| - | e
HaloCAD X
Connected as
Labelling Status
Owner
Sensitivity
Permissions View Edit Copy Print Export Change Rights
Expire access
0K
E“ @4‘ |j - Geometry -

The following table provides a brief description of each HaloCAD menu element.

# Icon Description

1 L =

The status icon displays the status of the file.

HaloCAD x
Connected as

Labelling Status
Owner
Sensitivity
Permissions View Edit Copy Print Export Change Rights

Expire access

oK

1. Connected as: Name of the logged-in user

2. Owner: Author of the document

Operations Manual 9 of 50
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# Icon Description
3. Sensitivity: Name of the label applied
4. Permissions: Rights on the file
5. Expire access: Displays the details of how long a user can access the labeled
file
6. Revoke Access: Revokes access granted for a protected document
7. Reset button: Logs off a user from the current active session. The button will be

disabled unless the user logs in again

2 The About icon displays the application version and license details. To learn more
about license activation, please refer to the section “License Activation” in the

Installation manual.
HaloCAD x

This add-in helps to protect the CAD files using Microsoft's RMS functionality in MPIP,

License Status None Activate
stop.exe ( ]
he.creopm.dll I}
oK
3 A The Sensitivity icon enables and disables the HaloCAD ribbon.

Click to change label
HaloCAD Ribbon l
o

/ Sensitivity | Mot set -

b £
Pencil icon - Click to change label:

1. Downloads the available labels.

2. Allows changing an applied label.

Operations Manual 10 of 50
Version 2025-05-08-V1



Secude

# Icon

Description

Sensitivity label list Click to cancel

@ Click to set Iabel
|
G Sensitivity --Mo Protection-- - o o

--Mo Protection--
--Custom permissicns-—-
Custom Permissions (Portal)
HCAD Public
HCAD Confidential
HCAD Secret
HCAD Internal
1. Green check mark - Click to set label icon - applies the selected label or
removes the existing label.
2. Red cross mark - Click to cancel icon - cancels the selected label.

3. Sensitivity label list - displays the label applied.
En 3@ D | HaloCAD: File Owned by john@halosecude.onmicrosoft.com

En 3@ D | HaloCAD: The Label name HCAD Confidential is assigned

Status bar displays the assigned label, owner information and the logged i

e-mail id.

nuser

Operations Manual
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4.3. How to Protect a CAD File (Standalone)?

Prerequisites:
1. To protect your organization's data by using sensitivity labels, configure the protection settings
to be associated with each label in the Microsoft Purview portal.
2. To set a default label for documents, configure the following settings in the Microsoft Purview
portal: Navigate to Label policies > Settings > Documents > Default settings for documents >

Apply a default label to documents > Select a label from the list.

Step 1: Open the Creo application

1. New file: Open a Creo model > enter a name for the file > create objects.

2. Existing file: Select and open a file of your choice.

Step 2: Download labels

1. Go to the HaloCAD tab, and click the Sensitivity icon.
2. You can see the Sensitivity set as Not set for any new file or existing unprotected file.
3. Click the Pencil icon (Click to change label). The first time you log in to HaloCAD, a connection to

Azure RMS is required, therefore HaloCAD will prompt you about the Microsoft Sign-In Assistant, as

seen below:

HaloCal >

i e 1 Microsoft Sign-In Assistant will be invoked and the user
4 credentials will be cached.

oK

4. Click OK and enter your credentials.

Operations Manual 12 of 50
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Sign in to your account X Sign in to your account X
B Microsoft BS Microsoft
S|gn in ¢ john@halosecude.onmicrosoft.com
john@halosecude.onmicrosoft.com X Enter paSSWOFd

sseeBeRIRREY
Can't access your account?

Back Next

A J

Forgotten my password

Q\ sign-in options

Terms of use  Privacy 8 cookies ... Terms of use  Privacy 8 cookies

5. After successful verification, a connection to your Microsoft Entra tenant is established and the
labels are downloaded from Azure RMS.
6. The credentials of the currently logged-in user are cached; however, if you want to erase the

credential cache, proceed to the section "Logging Off an Active User”.

7. If the default label has been configured in the label policies, it will appear in the Sensitivity; otherwise,
Not Set will be displayed. However, it can be relabeled or removed, which is explained in the later

section.
Step 3: Select and apply a label

From the Sensitivity list, select a label and then confirm the selection by clicking on the green check

mark - Click to set label icon.

Operations Manual 13 of 50
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dcreor | ]2 |l v~ cu - 52 33 ~ & 52| ¥ EXPS (PART) (Active) - Creo Parametric =
File HaloCAD Model Analysis Live Simulation Annotate

p® | @ | d 77 A A RReche @ B R MBS AQ O [
o= . x . . k= . ~
& I 1o x0T &~ Sweep ¥ ¥ v ] ) | E [
Regenerate Plane Sketch | Extrude Pattern | Boundary . | Component
- X (B2 il po i Swept Blend | G v & ~ - G A Bend” & Interface
Operations ¥ Get Data ™ | Body ¥ Datum Shapes Engineering ¥ Editing Surfaces ¥ Model Intent *
Maodel Tree -__'-" Folder Br "% | Favorites ~ = T A
e ) e @eaads1amd:EEL 1 3
Maodel Tree TJ hd g v i
T4 - 4 0 Sensitivity || --No Protection-- HR g o °
6 . --Mo Protection-- :
§ - --Custom permissions--
4 @ Bodies (1) Custorn Permissions (Portal)
5]} Import Feature id 1 HCAD Public
HCAD Cenfidential
HCAD Secret
HCAD Internal
o @ [ |- Geometry -

Downloaded labels for the signed-in user

Results:

1. The label is applied to the active document.
2. Click Save to save the file.

The following example shows the selected label on the HaloCAD ribbon along with its color configured
in the Microsoft Purview portal.

Operations Manual
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Ocreor | [ & H
HaloCAD Model Analysis Live Simulation Annotate View Applications
= ) pp

o &

Status About Sensitivity

e 5.5

£X | ¥ EXPS (PART) (Active) - Creo Parametric - 08 x

Information

ED Model Tree L‘ Folder B _# | Favorites

Model Tree Tj M= I3
T4 - Q Sensitivity | HCAD Confidential A - £
ﬁﬁ Expd

b (] Bodies (1)

5} import Feature id 1

1QQ3 20 AR EE

o @ [ i Geometry -

Opening a Creo file
To open a Creo file, first launch the Creo Parametric application, then choose File > Open > Select
a file. PTC does not recommend double-clicking files to open them; instead, they suggest using

the File > Open option according to the design.

4.3.1. Cancel, Remove, Relabel, and More

1. Canceling label selection - Unexpectedly, if you have chosen an inappropriate label, it can be
canceled by clicking on the red cross mark (Click to Cancel icon). This will cancel only the label that
is selected but not yet applied to the file.

2. Removing Protection - If you want to remove the existing label and keep the file unprotected,
select the --No Protection-- label from the list. Note: Whenever you make changes to the label, click
the green check mark (Click to set label icon) so that the updated label will take effect, and
click Save to save the file.

3. Relabeling - After applying the label, if you want to select a different label or a different set of

protection settings (Custom Permissions), first click the pencil icon (Click to change label) and then

Operations Manual 15 of 50
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select a different label from the list. For more details, refer to the section “Example 9: Custom

Permissions Label”.

4. Revoke Access: If an author does not want a user to access the shared file for security reasons, you
can prohibit it by clicking Revoke Access in the Status Ul. Please refer to the section “Example 11:
Revoke a File”.

5. Light Weight Graphics Simplified Representation - By default, assembly files will load in Creo in-
session along with their dependent files. To open a large assembly file quickly and minimize loading
time, you can select the Open Light Graphics option. By selecting this option, the file opens in a
lighter mode, without loading its models and feature data. The top-level assembly file is loaded into

in-session and displayed. To enable the Open Light Graphics, follow the steps below.

a. Go to the default installation directory of Creo. For example, <installation path\Common

Files\text\Config.pro>.
b. Add configuration property hide_pre_creo4_reps no and save the file.
c. Once the configuration has been saved, relaunch or reload the Creo application.

d. Go to File > Open. Choose any assembly file and select Open Light Graphics from the Open

drop-down list.
e. Only the top-level assembly file will be listed under Common Folders > In Session.

f. Double-click on the dependent files to load them into the In session.
4.3.2. Logging Off an Active User

To log off (or terminate) an active user from the HaloCAD session, perform the steps below:

1. Go to the HaloCAD tab > click Status > click Reset.
2. This removes the user identity from the logged-in user session. By doing this, the current user's
session will end and become available for other users to log on.

3. The following message will appear:

HaloCaD

f n y Want to reset Authentication details 7 Please save the file
A ' priorto reset,

Yes Mo

4. Click Yes.

Operations Manual 16 of 50
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5. The following message will appear:

HaloCaD >

Authentication reset completed. Please relaunch the CAD
l'x application.

QK

6. Click OK.
7. You need to restart the application.

Results

a. After relaunching the application, users can log in to a new HaloCAD session using their

credentials.
b. If you have not relaunched the CAD application, HaloCAD will alert you that, "For HaloCAD to
work properly you should relaunch the application now". Click OK on the message and

relaunch the application.
What to do next
1. Login after reset: After the restart, if you open a protected file or click on the pencil icon (Click to

change label), the HaloCAD will prompt you about the Microsoft Sign-In Assistant. Click OK and sign

in with your credentials.

HaloCal >

Microsoft Sign-In Assistant will be invoked and the user
¥ credentials will be cached.

oK

2. Save a Copy: If you want to save the protected file as other file types, go to the File menu >

click Save As > click the Save a Copy option.
a. Inthe Save a Copy dialog, select a location, file type, and filename, then click OK.

b. The file saved will have the same label.

3. Please refer to the section “Common Scenarios” to learn more about HaloCAD functionalities.
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4.4. How to Export a Protected CAD File to a PDF File?

To convert / export / save a protected file as PDF:

1. Go to the File tab > click Save As > in the Type list select PDF (*.pdf) > click OK.
2. A pop-up window PDF Export Settings will appear.
3. If you want to preview the file, select Open file in Acrobat Reader option and click OK.

Results: An exported PDF file is saved with protection.

The protected file may need to be viewed after being exported. To open a protected file, follow the

instructions below:

Prerequisite: Make sure that the latest version of Acrobat Reader DC/Acrobat DC.

1. Double-click the protected file or open the Adobe application, go to the File menu > Open > browse,
and select the file.
2. Microsoft Sign-in prompts you to provide your credentials.

3. Enter the credentials and click Sign in.
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4. To the question “Do you want to stay signed in?”, answer Yes.

Results:
a. Once you have successfully authenticated, the protected file will open.
b. If authentication fails, you will be prevented from accessing the file.
What to do next
To see the actual permissions that are applied to the file, do one of the following:

1. Click on the lock icon > Permission Details > Document Properties screen > click Show Details.

2. Click File > Properties > click Security tab > Document Properties screen > click Show Details.
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4.5. How to View a Protected File in HaloCAD Reader?

Who should use the reader add-on?
For customers who don't have the HaloCAD solution, Secude offers a viewer program to access

HaloCAD-protected files. End users can work with HaloCAD-protected data more easily without

installing the full version (standard) of the HaloCAD solution on their desktop.

Reader add-on Vs HaloCAD Standard add-on

Both add-ons utilize the security solution from Microsoft Purview. However, the reader add-on
cannot serve as a 'HaloCAD Standard' add-on. It can only read/open CAD files protected by the
Standard/Full add-on.

Prerequisite: Make sure that the HaloCAD Reader Add-on for Creo is installed.

1. Open the Creo application, go to the File menu > Open > open a protected file.

2. The HaloCAD will prompt you about the Microsoft Sign-In Assistant before it lets you access the file.

3. Click OK. Enter the credentials and click Sign in. (However, you do not require this validation, if your
cached account information is available.)

Results:

a. Aread-only version of the file opens with the following message.

HaloCAD >

':0:' File will be opened in read-only mode,

QK

b. Click OK on the HaloCAD reader message.

c. You can also notice the disabled pencil icon (Click to change label) in the Sensitivity ribbon,
disabled tabs, panels, and buttons in the CAD application, and disabled permissions (edit, copy,

print, export, and change rights options).

() sensitivity | HCAD Confidential - N
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What to do next:

The reader add-on gives you the following options, similar to the standard add-on:

1. To view the file's permissions, click the Status icon.

2. To log out an active user from a HaloCAD session, click the Reset icon.
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5.Common Scenarios

This section presents some common scenarios for illustrative purposes and is meant to provide

general guidelines.

5.1. Concept: Sensitivity Labels

MPIP labels can be customized to meet the requirements of every organization. The labels are defined
and managed directly on the Azure portal, and the HaloCAD Add-on retrieves them to make them
available for user selection. The permission levels associated with a sensitivity label are automatically
imposed on the document when you apply it. Any rights that you do not specifically grant will not be
assigned to the user. A label (with view permission) applied to confidential data allows users to only

access the content and nothing else.
1. Let's say, for example, that you set up a label with the "Viewer" permission. In this case, the user will
be able to view MPIP-protected content, but the following actions and menus will be disabled:
a. Pencil icon - Click to change label in the HaloCAD Sensitivity ribbon.
b. All tabs, panels, and buttons in the CAD application.
c. Edit, Copy, Print, Export, Change Rights, and Revoke options in the Status Ul. Refer to Example 1.
2. In contrast to the previous point, if you configure a label with '‘Co-Owner' permission, the user will
have full access to the file, including the ability to view, edit content, print, copy, and export the file, as

well as change rights (labels). Refer to Example 2.

3. For more details on labels, please refer to Microsoft Documentation.
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5.2. How to Open a Protected CAD File?

Follow the below procedure to view the protected file:

1. Click on the protected file. The HaloCAD will prompt you about the Microsoft Sign-In Assistant when
you attempt to open a labeled file for the first time.

2. Click OK when prompted, "Microsoft Sign-In Assistant will be invoked and the user credentials will be
cached."

3. Follow the on-screen prompts to complete the authentication process.

4. On successful confirmation, the file will open.

5. Depending on the policy settings, users may get different access results for the same

document. Please refer to the following examples.

5.2.1. Example 1: Label with Read-only Access

1. The file presented below is labeled HCAD Confidential, which allows the user to view the data but
restricts other activities on the file. Additionally, screen capture using PrtScn/Snipping tool/Copy
(Ctrl+V) is prevented and ribbon tabs and panels are disabled.

2. Click the HaloCAD tab, then Status to see the label and your file permissions.

decreo |18 H 2 9 v & 52| ¥ EXPS (PART) (Active) - Creo Parametric = (=l %
HaloCAD Maodel Analysis Live Simulation Annotate Tools View Applications o = 5

e :

9 &

Status About Sensitivity

Information

=]
oo Model Tree = Folder B # | Favorites |
= — - B </; Sensitivity | HCAD Confidential hd -
Model Tree T} v &g v %R
! ) A
I5§ Exp8
» (7] Bodies (1) HaloCAD *
- .
Import Feat d1
—J’§ DT Connected as derek@halosecude.onmicrosoft.com Reset
Labelling Status
Owner jehn@halosecude.onmicrosoft.com
Sensitivity I HCAD Confidential
Permissions View Edit Copy Print Export Change Rights
Expire access MNever
oK
Eu f{#‘ _I HaloCAD: File Owned by john@halosecude.onmicrosoft.com n - Geometry -
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What Happens if You Try to Copy Data or Save File or Print Screen?

The most common technique for stealing confidential information is to copy it (Ctrl + C), take a
snapshot using the Print Screen (PrtScn) or snipping tool, and then transmit it somewhere else.
Therefore, either taking a picture or copying, the entire contents are blanked out. This is because the
label without the "Copy" usage right prevents data copying and screen captures. Similarly, when the user
clicks on the File menu, other options such as Save, Print, and so on are disabled because the user does

not have the authorization to perform any of these operations.

¥ Snipping Toel
File Edit Tools Help

-E_l_f}l,ew Bl Mode ~ 4 Delay ~ [ 5 & T - v

File with View only permission

Creo

Parametr...

E HaleCAD

Creo

Connected as derek@halosecude.onmicrosoft.com
Modelche...

Labelling Status

q Cwner john@halosecude.onmicrosoft.com

Google
Chrome

Sensitivity I HCAD Confidential

Permissions View Edit

B Expire access Newver

Recycle Bin

Change Rights

|z : = _ Lo 1310
£ Type here to search : e i ~ Tl ) ENG 04-08-2022 S

What Happens if You Try to Relabel with Read-Only Permission?

With "Read-only / View" rights, you are only allowed to view the content; all other options, including the
tab, panel, button, and pencil icon - Click to change label on the HaloCAD Sensitivity ribbon, are

disabled. As a result, the imposed protection cannot be relabeled or removed.
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Sensitivity | HCAD Confidential - -
Model Tree ‘Tll - g v By 0
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5.2.2. Example 2: Label with Full Control Access

1. The file shown below is labeled HCAD Confidential, which grants the user full access, therefore all
menus are enabled in the file.

2. Click the HaloCAD tab, then Status to see the label and your file permissions.
| dcreo' |12 o~ cu~i8 33~ § 2|5 EXPS (PART) (Active) - Creo Parametric

HaloCAD Model Analysis Live Simulation

=l
Annotate Tools View Applications =

Wl eat
|
me &
Status About Sensitivity
Information
Model Tree -j'-" Folder Br "% | Favorites
g - | O Sensitivity | HCAD Confidential - R /
Model Tree ‘Tl]l - g v B
i i A
Bl Exe HaloCAD x
» [7) Bodies (1) a0
- .
| rt Feat d1
‘=1’§ i Connected as john@halosecude.onmicrosoft.com Reset
Labelling Status
Owner jehn@halosecude.onmicrosoft.com
Sensitivity I HCAD Confidential
Permissions View Edit Copy Print Export Change Rights
Expire access Never Revoke Access
OK
g @ ] HaloCAD: The Label name HCAD Confidential is assigned i 11hg Geometry -
User with full access
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What Happens if You Try to Relabel with Co-Owner Permission?

With "Co-Owner" rights, you have complete control over the content and can relabel or remove the

protection as needed by clicking the pencil icon - Click to change label on the HaloCAD Sensitivity

ribbon.

5.2.3. Example 3: Unauthorized User Access

An unauthorized user who double-clicks on a protected CAD file receives the warning shown below.

- - ¥ wsin-arulk ® 05 (C:) ¥ Users » Abby ¥ Desktop - [¢¥| |Search...
_|_|.|JOrgar1ize-r 2 Views ~ l"T'}Tu:u:uls-»--- [E?
Commeon Folders 1.0.0.1
[ In Session [} mydesign.prt
[ Desktop
(=l My Documents
B wsin-arulk HaloCAD x
&

7] Working Directory
‘& System Formats
‘=] Manikin Library

% Favorites

oF MNetwork

b Folder Tree

':8:' You do not have sufficient permissions to view this document.

File name: mydesign.prt Date modified: 27-MNov-19 01:18:47 PM Preview
File name: | mydesign.prt Type| Creo Files (.prt, .asm, |+
Open A Cancel

5.2.4. Example 4: Labeling Dependent (Protected and Unprotected) Files

Assume there are dependent part or sub-assembly files that are protected and unprotected in a Parent

Assembly file. When you apply a label to the Parent Assembly file, you must confirm for the following

action to take effect.
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HaloCAD

4% Do youwish to re-label the protected part and

' | sub-assemblies as well?,

— Yes - all the protected and unprotected part /sub-assemblies
will be labelled.
Mo - only the unprotected part/sub-assemblies will be

labelled

If Yes, then

1. All the associated unprotected child files will receive the Assembly file's label uniformly.
2. Already protected child files will be relabeled with the Assembly file's label.
3. If that child file(s) does not have Owner/Co-owner rights, then the Parent's label cannot be imposed

on the file.

If No, then

1. Only the unprotected files will get protection.

2. Existing protected child files will be unchanged.

Note: If you want to remove the label, you can do so with owner rights. The label gets removed from
both the Parent Assembly file and child files if you click Yes in the above message. If you click No in the
above message, the label gets removed only from the Parent Assembly file and the existing protected

child files label will be unchanged.
5.2.5. Example 5: Labeling Dependent (Unprotected) Files

Assume there are dependent part or sub-assembly files that are unprotected in a Parent Assembly file.
You will receive the following message if the Parent Assembly file is relabeled or a new label is applied,

or the file is not protected.

HaloCAD >

i 0 1 The selected label will be applied to all unprotected
k. Y dependent files.

Click OK - all unprotected dependent files will be labeled.
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5.2.6. Example 6: Removing Protection from Assembly & Part Files

Assume there is a protected Parent Assembly file that contains part or sub-assembly files. If you want
to keep the file unprotected, remove the existing label and apply --No Protection-- label to the Parent

Assembly file, you will receive the following message:

HaloCAD

; . Do you wish to remove the protection for part and
\ | sub-assemblies as well?,
= ¥es - Protection will be removed from all the dependent

part/sub-assemblies,
Mo - Dependent files label will not be removed

Yas Mo

You must confirm for the following action to take effect:
If Yes, then
1. All associated protected child file labels will be removed, and the files will be unprotected.

2. If that child file(s) does not have Owner/Co-owner rights, then the removing protection from the file

cannot be imposed on the file.

If No, then
1. Only the Parent Assembly file’s label will be removed and unprotected.
2. The existing protected child files label will be unchanged.

5.2.7. Example 7: Label with Content Marking

Applying a watermark indicates what type of content it is and how it should be handled, and its
presence in a file serves as a constant reminder to the user that the file contains sensitive information.

The file below is labeled HCAD Secret and bears the watermark Secret.
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5.2.8. Example 8: Other Use Case Scenarios
5.2.8.1. Importing a file with a restricted/least permission label

A restricted/least permission label refers to a label with the lowest permission, such as view-only
access rights. A full permission label has full access rights, such as Edit, Export, Change Rights, and so

on.

1. Case 1 - When you import a dependent part or sub-assembly file protected with a “restricted
permission” label into a parent assembly file protected with a “full permission” label, the following
HaloCAD pop-up message appears as “Please confirm applying least permission label from import

file? Yes - Current file will be updated with import file label No - Import operation will be cancelled.”

a. If Yes, then the imported dependent part file’s label will be applied to the parent assembly file.

For example, the HCAD Public label with view rights will be applied.

b. If No, then the import will be blocked, and the parent assembly file will remain unchanged.

2. Case 2 - When you import a dependent part or sub-assembly file protected with a “full permission” or

“restricted permission” label into a parent assembly file that is unprotected, the HaloCAD pop-up
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message appears as described in Case 1 above. The response (Yes or No) process will also follow
the same procedure as in Case 1.

3. Case 3 - When you import a dependent part or sub-assembly file protected with a “full permission”
label into a parent assembly file protected with a “restricted permission” label, the import is allowed,

and no label changes occur in the parent assembily file.

In addition, when an assembly file is opened, all linked part or sub-assembly files are checked to
determine the least restrictive permission among them. If any part or sub-assembly file has the lowest
permission level, the parent assembly file adopts that restriction. For example, if a part file is set to

'view-only', the assembly file is also enforced to 'view-only' upon opening.
5.2.8.2. Labeling a File Without Protection

In contrast to a standard MPIP label, a "label-only” MPIP label simply adds metadata to a file. In this

context, "label-only" refers to adding metadata to a file.

The primary difference between the standard "MPIP label" and the "MPIP label-only" is that the former
includes encryption options, whereas the latter does not. Thus, “MPIP label-only” can be added to any

file that does not require protection but simply needs to be labeled.

Prerequisite: Make sure the Control access check box under the Choose protection settings for the
types of items you selected page is unchecked while defining the label-only in the Microsoft Purview

portal.
Other key points
1. When the label is applied to a file, the label name will be added to the suffix, '(Label Only)'. In the

example below, the actual name defined in the portal is HCAD Metadata. After applying to a file, the
label name appears as 'HCAD Metadata (Label Only)'.

9
/\/ Sensitivity: HCAD Metadata ( Label only ) .

2. Full rights: A file with this label allows a user to have full rights on it.

3. Notifications: Similar to a standard MPIP label, the user will receive notifications when label-only is
applied to a top-level parent file.

4. With the HaloCAD Add-on: The label details will be displayed in the Status Ul, just like a standard
MPIP label.

5. Without the HaloCAD Add-on: A file with a label-only MPIP label will behave like any other
unprotected CAD file.

6. Properties: To see label details, follow the instructions below:
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a. Go to the Tools tab > click Parameters.
b. You can view the author name, label ID, and label name in the Parameters window.

c. Furthermore, if watermarking is configured in this label, the Parameters window displays

additional information such as the font color, font name, font size, layout, and text.

5.2.9. Example 9: Custom Permissions Label

Difference between Sensitivity Labels and Custom Permission Labels

Sensitivity Labels - These labels are maintained by each organization's administrator who defines
the permission set in the Microsoft Purview portal. These are also known as administrator-defined
permissions.

Custom Permission Labels - These are the sensitivity labels where the HaloCAD add-on allows the
user (author) to set the permission when applying a label. These are also known as User-defined

Permissions.

5.2.9.1. Protection using Custom Permissions from Microsoft Purview Portal

Prerequisite: Make sure the custom permissions label in the portal is set to Let users assign

permissions when they apply the label.

-No Protection--

—~No Protection-
—Custom permissions- €= Label with custom permissions from HaloCAD Add-on
Custom Permissions (Portal) === MPIP label configured with custom permissions
HCAD Confidential
HCAD Internal .

€&——— MPIP static labels
HCAD Public

HCAD Secret

Custom permissions and other labels

Follow the procedure to apply the custom permissions label:

1. Open the Creo application, select a model, and then create objects.

2. Click the Click to change label icon.

3. When HaloCAD downloads the labels, it will also list custom permission labels in the Sensitivity
Ribbon.

4. For illustration, the custom permission label is named Custom Permissions (Portal).
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5. Select the Custom Permissions (Portal) label from the list and click on the green check mark - Click
to set label icon.

6. You will receive the HaloCAD Custom Permissions screen as shown below:

HaloCAD x
Custorn Permission

. Viewer - View Only -
Select Permission !

derek@halosecude.onmicrosoft.com; john.sales@microsoft.com;
Enter Users, Groups, or Organizations support@halocad.com; marketing@delbontindustries.com; tech.cad.com;
media.3d.net

Expire Access . . .
P 31-12-2026 Clear date selection

Apply Cancel

7. From the Select Permissions list, select the level of access you want the users to have when you
protect the file (Viewer - View Only / Reviewer - View, Edit / Co-Author - View, Edit, Copy, Print / Co-
Owner - All Permissions / Only for me).

8. Specify the users who should have permission to access your file in Enter Users, Groups or
Organizations. Type their full email address, a group email address, or a domain name from the
organization for all users in that organization, separated by a comma, space, or semicolon.

9. You can specify how long the labeled file can be accessed in the Expire access field. Use the Never
option if you want the label to never expire and to have unlimited access to the file. It can be used for
less sensitive content. Alternatively, for highly sensitive content, enter an expiry date (dd-mm-yyyy)
so that recipients other than the owner cannot access the file after the expiry date.

10. Click the Clear date selection option to clear the previous date selection.
11. Click Apply to confirm the protection setting.
Results: The label is applied to the file.

What happens when a user opens the custom permissions labeled file?

Based on the user’s permission, the file can be consumed. Note: The author of this document will have
full rights to this file. He can always access it, regardless of custom permissions or expiry date that
might have been configured in that label. The following is an example of a label with custom

permissions.
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5.2.9.2. Protection using Custom Permissions via HaloCAD Add-on

In comparison to the previous section, the HaloCAD add-on also includes the Custom permissions label.
On the other hand, the HaloCAD add-on gives rights at the application level and is not obtained from the

Microsoft Purview portal. The process for applying the label is the same as in the previous section.
5.2.10. Example 10: Set an Expiration Date for File Access

Prerequisites:

1. Make sure that the expiration date is configured in the Microsoft Purview portal in case of using a
static MPIP label.
2. Make sure that the expiration date is configured in the Custom Permissions label if using via the

Purview portal and/or HaloCAD add-on.
5.2.10.1.Why is File Expiration Necessary?

When you share a file with an external vendor, they will have access to the file long after your business

contract has ended. Allowing vendors and former contractors to access your file leads to security risks.
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To prevent this from happening, you can set an expiration date for the file. Defining an expiration date
on your file is good practice, especially when working with external vendors or contractors. It's one

more key step to strengthening the security of your company and customer data.

For instance, assume that you have sent a file with an expiration date of 31/12/2026. Business partners
who consume it cannot open it after 31/12/2026. Whenever the file is opened, HaloCAD reminds the

validity of the file.

HaloCAD *

':o:' Permission will expire on 31/12/2026

.................................

.................................

5.2.10.2.What Happens When a File Expires?

When a user opens a file that has reached its expiration date (in his or her current time zone), the user
will be unable to open the labeled file. HaloCAD will prompt a message “You do not have sufficient
permissions to view this document”. This behavior is like unauthorized file access, as described in the

section “Example 3: Unauthorized User Access”.

5.2.10.3.How to Open the Expired File?

The recipient cannot open the expired file. The author of the file can only open the expired file. If the
recipient still wants to access the file, then the recipient needs to contact the author of the file to issue

a new copy of the file with a different expiration date.
5.2.11. Example 11: Revoke a File

Prerequisite: Make sure to check that the user who wants to revoke a file has been assigned the

required license, as specified in the Release Notes under the Requirements section.

MPIP offers a revoke feature to end users, which prevents any new access attempts to a protected file
and seals it safely from all users except the author. Please note that revoking access also means that

you are withdrawing access to all the users associated with that label.

5.2.11.1.Why Should a User Revoke a File?
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A user may want to revoke access to a sensitive file for various reasons:

1. When an author sends out an old or unapproved version of a file by mistake.

2. When an author foresees an access attempt from a malicious user or location that seems
suspicious.

3. When your network is breached, or your files are leaked.

4. When a recipient is no longer a part of your organization, or when you no longer want to share
specific files, or when a contract expires, etc.

The author can take immediate action to prevent the further spread of the file by revoking access.

Please note that when a file is revoked, it does not delete the actual file that you shared, but authorized

users will NO longer be able to open it. The Revoke Access button is on the HaloCAD status screen.
5.2.11.2.How to Revoke a File?

1. To revoke a file, go to the HaloCAD tab > click Status > click the Revoke Access button. The

following message will appear:

HaloCaD

@B FRevoke access prevents user from accessing any copies of this
' ' file that have same protection applied.,

Do you want to revoke access now?

2. Click Yes to confirm revoke access and continue with step 3. If you do not have the required license,

it is not possible to revoke a file. In this instance, HaloCAD will show the alert as follows:

HaloCAD x

I-" “'—I Mo permission to revoke access to this file, To continue,
5 ' contact your administrator,

QK

3. The following message will appear:
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HaloCAD >

f 0 y Access to this file is now revoked, Users can no longer access
' copies of this file with the same protection.

4. Click OK and save the file.

Results:
a. Access to the file is revoked.

b. Users who were previously able to access the document are no longer able to do so.
5.2.11.3.What Happens if a User Attempts to Open the Revoked File?

Once the file is revoked, the user cannot open it, although the user has accessed it before. HaloCAD
shows a generic message as “You do not have sufficient permissions to view this document.” This

behavior is like unauthorized file access, as described in the section “Example 3: Unauthorized

User Access”.

MIP SDK

A revoked file can be accessed by the same user if it was previously opened by the same user in
the same HaloCAD session. This is due to the actual behavior of the MIP SDK if you have defined
the sensitivity label with the two options Allow offline access and Users have offline access to
the content for this many days, the configured offline access allows users to continue to access

the revoked file until the offline policy period ends.

5.2.11.4.What Happens if a User Changes the Label?

Assume that User A shares a sensitive file with User B.

e Case 1: User B makes copies of the original document and when User A revokes file access, all
copies of the original document will be revoked, as the label does not change.

e Case 2: Assume User A has not yet revoked file access. User B with full rights changes the label.
At this point, if User A revokes file access, the revocation cannot be applied to that copy of the file

because of the change in the label. However, the original document will have been revoked.
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5.2.11.5.How to Open the Revoked File?

A recipient cannot open a revoked file. The author of the file can only open the revoked file. If the
recipient still wants to access the file, then the recipient needs to contact the author of the file to issue

a copy of the file without revoking it.
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6. Troubleshooting

This chapter will help you overcome the most common problems with the HaloCAD solution.

6.1. Cannot Sign in to Microsoft Sign-In Assistant

Symptoms

The user login fails with the following error message.

Sign in to your sccouwnt -
m Microsoft
Sign in

Sormy, but we're having trouble signing you in.

AADSTSS0011: The reply URL specified in the request does
not match the reply URLs configured for the application:

WBcal T6-c Tde-43T7d-9Bef-B62ech5T5 1M

Background
The above error occurs when a user logs in to a HaloCAD session using Microsoft Sign-In Assistant.
Probable Cause

As the Redirect URL specified in the request does not match the URL configured for the registered

application, Microsoft Sign-in fails.
Corrective Action
1. Case 1: An incorrect Redirect URI is entered during the HaloCAD installation.
a. Install the HaloCAD Add-on again using the proper Redirect URI.
b. Launch the CAD application, click the pencil icon - Click to change label, and sign in to
Microsoft Sign-In Assistant.
2. Case 2: Redirect URIs with the improper scheme (such as http://contoso.com)

a. Loginto the Microsoft Azure portal.
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b. Onthe home page, click the Show Portal Menu icon, and then select Microsoft Entra ID from

the list.
c. Under the Manage node on the Overview page of your tenant, choose App registrations.
d. Click All Applications, then enter the name of your application into the search bar.
e. From the list, choose your application.

f. Either click the Redirect URIs link or select Authentication from the Manage node on the

application overview page.

g. Verify that the reply URL contains https://. If not, add https and save the file.

o) Secure Application | Authentication =

|}3 Search | « a7 Got feedback?
B Overview : L e
Mobile and desktop applications Quickstart  DocsC i
Quickstart Redirect URIs

The URIs we will accept as destinations when returning authentication responses
(tokens) after successfully authenticating users. The redirect URI you send in the
request to the login server should match one listed here. Also referred to as reply
URLs. Learn more about Redirect URIs and their restrictions

% Integration assistant

Manage

B2 Branding & properties T ) ) R
g & prop D https://login.microsoftonline.com/common/oauth2/nativeclient @

—3‘ AL D https://login.live.com/oauth20_desktop.srf (LiveSDK) |E

Certificates & secrets [[] msalsfdb3a18-930b-40b9-9547-9b9b118014b5://auth (MSAL only) [Py

Il Token configuration —
https://secureapplication @

<+ APl permissions

Expose an AP

App roles -

h. Now, log in to Microsoft Sign-In Assistant.

3. Case 3: Tenant ID provided for multi-tenant application
a. Reinstall the HaloCAD Add-on without entering the Tenant ID.

b. Open the CAD application, click the pencil icon - Click to change label, and log in to Microsoft

Sign-In Assistant.
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6.2. Labels are not Getting Downloaded in the HaloCAD Session

Symptoms

The user could not download labels.

Background

The user logs in successfully in the HaloCAD session but cannot download labels.
Probable Cause

Improper label configuration in the Microsoft Purview portal.

Corrective Action

1. Log in to the Microsoft Purview portal as a global administrator.

2. Ensure that the labels are configured to apply protection.

3. Make sure the user has the policy to use the label.

4. Please refer to Microsoft documentation for a comprehensive description.
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6.3. Label not Found in the Policy

Symptoms

HaloCAD prompts the following message:

HaloCAD
The selected label was not found in the policy or not suitable
for protection,
Are you sure to close the drawing without save?
Yes Mo
Background

The above message is shown when you apply a label to a file and save it.
Probable Cause

Improper label configuration.

Corrective Action

Request your Microsoft Purview portal administrator to review the label and publish label policies.
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6.4. Double Key Encryption Label Could not be Applied

Symptoms

HaloCAD prompts the following message:

HaloCAD bt

| The selected label could not be applied.
. MetwarkError: Mo Connection

K

Background

The above message is shown when you apply a Double Key Encryption (DKE) label to a file and save it.
Probable Cause

This issue occurs if the DKE service is stopped or unavailable.

Corrective Action

Make sure that the DKE service on the client's computer is active and accessible online.
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6.5. Could not Connect to Azure RMS - Case 1

Symptoms

HaloCAD prompts the following message:

HaloCAD X

ERROR: Could not connect to Azure RMS due to
MoAuthTokenError

Background
The above error occurs when a user logs in to the HaloCAD session via Microsoft Sign-In Assistant.
Probable Cause

This issue occurs if one or more of the following conditions are true:

1. Case 1: You have entered the incorrect Application (client) ID, Directory (tenant) ID, and Redirect
URI.

2. Case 2: You have closed the Microsoft Sign-In Assistant dialog unknowingly.
Corrective Action
1. Case 1: Make sure the correct values of Application (client) ID, Directory (tenant) ID, and Redirect

URI are entered during the initialization.

2. Case 2: Relaunch the application and enter user credentials in the Microsoft Sign-In Assistant dialog.
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6.6. Could not Connect to Azure RMS - Case 2

Symptoms

HaloCAD prompts the following message:

HaloCAD X

ERRCOR: Could not connect to Azure RM5 due to
MNetworkErronMoConnection

Background

The above error occurs when a user logs in to the HaloCAD session via Microsoft Sign-In Assistant.
Probable Cause

The most likely cause of this issue is your network is preventing you from connecting to Microsoft

Purview Information Protection.

Corrective Action

1. Review your firewalls or network infrastructure to establish a connection with Azure.

2. Check if your proxy limits the URL.
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6.7. HaloCAD Activation Fails

Symptoms

HaloCAD prompts the following message:

HaloCAD >

This license key has already been activated the maximum
number of times.

Background

The above message is shown when you try to activate HaloCAD on a system.

Probable Cause

After the first successful license activation, the license's status changes to Active, and the number of

Total activations in Secude's License Server Manager increases by one. This means that the number of

Total activations increases with each activation.

For example, if you purchased ten CAD licenses, after the tenth activation, you will be unable to activate
CAD on another system. The License Server Manager displays the error message because you have

reached the license's maximum number of activations.

Corrective Action

1. Action 1: Uninstall one or more add-ons that were previously installed before activating the license
key on the other add-ons.
2. Or Action 2: Purchase a new HaloCAD license.

3. Now, activate the license.
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6.8. Incorrect License Key Error Message

Symptoms

HaloCAD prompts the following message:

HaloCAD >

e License with the provided license_key not found.

Background
The above message is shown when you try to activate HaloCAD on a system.
Probable Cause

There are various possible reasons, including a license key associated with another HaloCAD, an

incorrect key, or an invalid key.
Corrective Action

Make sure to enter the correct licensing key, unique to this add-on, before activating it.
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6.9. Why Am | Getting License Expiration Notifications?

Symptoms

HaloCAD prompts the following message:

HaloCAD =

o Your license will expire in 15 days.

Background

The above notification occurs once a day when a user logs into the HaloCAD session.
Probable Cause

When you run the CAD application and encounter an expiration alert, it signifies you must take action to
continue using HaloCAD.

A license's end date is set when it is issued. When the license expiry is less than 30 days away, the
License Manager prompts HaloCAD to notify the user. For instance, if your license expiration date is set

to September 31, 2026, the user will begin receiving notifications once per day on September 1, 2026.

Corrective Action

1. Purchase a new HaloCAD license or renew the existing license.

2. Activate the license.
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6.10. Other License Related Error Messages

HaloCAD License Error

Messages

The license validity period has

expired

The license is not enabled.

This device is blacklisted.

This license cannot be activated
before the start date: yyyy-mm-
dd.

Date header is not valid or set in

past.

Root Cause

When your license had just

expired.

When you try to activate a
license key that is already

disabled on the License portal.

When your device is blocked in
the license portal for a specific

reason.

When attempting to activate a

license before its start date.

When the date or time on the

machine is incorrect.

Correction Action

Please contact Secude's
representative to receive a new

license.

Please contact Secude's
representative to enable the

license.

Please contact Secude's
representative to enable the

device.

Please make sure the license is

activated on the start date.

Please make sure that the
machine installed with the
HaloCAD add-on is synchronized

with the current date and time.
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7.Customer Support

Please be ready with the information listed below before contacting our team to help you with the issue

you are experiencing. The data that you provide will help us serve you better.

1. Full contact details.

2. HaloCAD Add-on build version.

3. Date, time, and description of the error (if possible, provide screenshots).

4. What (if any) third-party products (software or other) were used in conjunction with our product?

5. Any other information necessary to reproduce the error.

Secude offers help and support through

1. Technical support email: support@secude.com

If you choose to contact us by email, please provide your company details and a detailed description
of the issue, as well as the log file (if any). Our representative will respond to your email inquiry.
2. Phone support: Call +41 41 510 70 70 to talk to our representative to diagnose and resolve the

technical problem.
Other resources

Please visit https://secude.com to know about upcoming events, press releases, and to download

whitepapers.
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8. Documentation Feedback

Secude understands the importance of technical content when attempting to gain product knowledge
and strives to continuously improve product documentation to ensure that users receive the
information they want. To provide feedback on the documentation, please send an email to

documentation@secude.com. Please include the following details in your feedback:

1. Product name and version
2. Documentation topic
3. Details of the suggestion or error

The technical documentation team will consider your feedback and address it in future documentation
updates.
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About Secude

Secude, a Microsoft and SAP Partner, is a global leader for Zero Trust Data-centric security and

Enterprise Digital Rights Management (EDRM) solutions.

For more than 25 years Secude has been trusted by many Fortune 500 and DAX-listed companies
for architecting, implementing, and protecting their data. Our data-centric security professionals
apply their passion and deep domain expertise to provide a holistic approach to protect priceless

Intellectual Property (IP) in CAD & SAP based collaborations and supply chains.

With branches in Europe, North America and Asia, Secude supports customers with the imple-

mentation of IT security strategies through a global network.
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